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DocuShare Introduction

Introduction

Welcome to the Jefferson Lab’s DocuShare User Training Manual.

DocuShare is a web-based document management system that lets you easily store, access, and share information in a collaborative work environment. DocuShare fulfills the promise of the Web and collaborative computing by making it possible for you, the user, to publish and manage collections of information on an intranet without knowledge of Hypertext Markup Language (HTML). In addition to documents, DocuShare’s collections can also include calendars, URLs, and bulletin boards.

The information that you store in DocuShare is organized using nested folders called collections. Collections may contain other DocuShare objects such as files, calendars, bulletin boards, URLs and other collections. Any of these DocuShare objects can appear in multiple collections at once and can be found quickly by using the various DocuShare navigation and search features.

Module 1: 
Logging In & Out 

Objectives

Upon completion of this module, you will be able to:

· Log In and Log Out of DocuShare

Introduction

When your department liaison requests a DocuShare account for you, your profile is created in the system with information such as your name, e-mail address, phone number, username, and DocuShare password. Your username and password will, in most cases, be your Jlab username and password. To be able to see restricted information, or to add and edit information, you must first have an account. If you have questions about getting access to DocuShare, email support at docushare@jlab.org for assistance.

1.1
LOGGING IN 

Use this procedure if you already have a username and password in DocuShare and if you are not already logged in.

1.
Open your browser to https://jlabdoc.jlab.org/docushare.
2.
You will see the Login prompt on the left side of the screen.
3.
Type in your JLAB CUE Username and tab to the next field.

4.
Type in your Password.

5.
Make sure JLAB is chosen in the domain dropdown (unless you were specifically told by Docushare Administrators to do otherwise).
5.
Click on Login. The system will confirm your login.

RESULT:  You may log in at any time and from any collection by using this procedure. Remember that each time you restart your browser you will need to log back into DocuShare. 

1.2
LOGGING OUT

You are automatically logged out of DocuShare when you close your browser session. To ensure the security of your documents do not leave your computer unattended and/or leave your screen unlocked.  Alternatively, you may log out by clicking the Log Out link on the sidebar. The Docushare welcome page will appear with the login prompt on the left side. At this point, click on the Logout link to confirm your logout. 
RESULT:  You have now logged out of DocuShare. 

Review

· User IDs and passwords are case-sensitive.

· If you need assistance with logging in, email docushare@jlab.org for assistance.
· You need to be logged into DocuShare in order to add, modify, or delete objects.

Module 2: 
Collections

Objectives

Upon completion of this module, you will be able to:

· Add Collections to DocuShare

· Edit Information About Existing Collections

· View Collection Permissions

Introduction

A collection is the DocuShare equivalent of a folder and is represented by the [image: image2.png]


 icon. Collections are considered container objects, which mean that they can hold other DocuShare objects (e.g., other collections, documents, bulletin boards, URLs, saved queries, or calendars). You can add a collection to another collection if you are logged in and have Writer access to the existing collection. You may update the meta-information, or properties, of a collection at any time without altering the content of the collection. For more information about collections, refer to the User Guide.

Keep in mind that all DocuShare objects are assigned a unique URL and can be bookmarked for easy retrieval. This is helpful if you will need to return often to a particular object.
New Terms

Bookmark – A shortcut to a web location that is remembered by your browser for quick and easy navigation.

Collection – Also known as a folder, a collection is a user-defined group of DocuShare objects containing documents, calendars, saved queries, bulletin boards, or other collections (folders).

Drop-down Menus – A set of menus that assist users in performing tasks related to the creation or management of collections and objects in DocuShare.

Meta-information – Refers not to the content of a document or object, but to the properties and information about the object, such as the title, owner, summary, description, number of versions, etc.

2.1
ADD A COLLECTION

NOTE:  You must be logged into Docushare and must have been assigned privileges by your department liaison or the Docushare Administrator in order to add/modify content.

1. Navigate to and open the collection to which you want to add a collection.

The collection page opens showing all of the objects in the collection.

2. From the Add menu, select Collection.

The Add Collection page appears.
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3. In the Title field, enter a name for the collection. The name should be short, but descriptive, and can contain spaces and punctuation marks.

4. Enter any optional information. Click a field name for a description of each property.

NOTE: If your administrator created custom properties, they also display on the page. See your administrator for information about custom properties. 

5. Click Apply.

The Properties page for the collection appears, displaying information about the new collection.
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6. You can click the collection name displayed in the Location breadcrumbs to open the collection.

RESULT:  You have now learned how to create collections. Each collection may contain other DocuShare documents and objects, including additional collections
2.2
EDIT COLLECTION PROPERTIES

To view and change a collection’s properties:

1. Locate the collection whose properties you want to view and change.

2. Do one of the following:

· If the collection is open, click the Edit Properties link in the upper-right corner of the window.

· If the collection is not open (you can view its title in a collection), click the Properties icon that appears to the right of the collection’s title.

The Properties page for the collection displays the read-only properties.

3. Click the Edit tab.
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4. Change the properties you want. Click a field name for a description of each property.

NOTE: If your administrator created custom properties, they also display on the page. See your administrator for information about custom properties.

5. Click Apply.

Note:  You can change information about DocuShare collections at any time without this action altering the content of your collections.

RESULT:  You have now learned how to edit collection properties. You must be the manager of the collection or have Write access permission to edit the properties of a collection.

2.3
VIEWING COLLECTION PERMISSIONS 

1. Locate the collection whose permissions you want to view.

2. Click the Properties icon that appears to the right of the collection’s title.

The Properties page for that collection appears.

3. Click the Permissions tab.

[image: image6.png]Collection Services - Mozilla

le Edt Vew Go Bookmarks ook Window Hep

JeffersonLab > CI0 > IR Privacy and Security Notice

I e

@ocusnare

Home | Content Map | Whats New | _Users and Groups | Help |

cochran Logout Adrin Home My Docushare My Tasks search: This Callection | [Go ] ~ Advanced

Properties for Sample Collection
Location: Home » Infastructure » General Services » Library » Sample Collection Properties

Permissions

Title: Sample Collection

Owner: Dana Cochran (User-247, cochran: JLas) ((Change Owner

Search Available to: @ anyone O Access list only
Access Lis

User/Group [Reader [writer [Manager
Dana Cochran (cochran) | v/
Content Administrators| v/
All Users and Guest

Site Administrator (adrmin)

Site Administrators
Change Access List

Apply only changes to: v,

© This container only
@ This container and its objects, including same objects that appear in other containers

© This container and its objects, excluding same objects that appear in other containers

Reset
Delete | [ Add ta Favorites

6 &b 2 B8 @ Done





RESULT:  You are able to view the permissions collections at any time. We will discuss how to change and manage collection permissions in Module 4 of this workbook. 

Review

· A collection can contain a variety of types of objects.

· You may organize your information in ways that make sense to you.

· Information about a collection can be updated at any time.

Module 3: 
Documents
Objectives

Upon completion of this module, you will be able to:

· Add Documents to DocuShare

· Edit Document Properties

· Lock an Existing Document
· Add an Updated Document
· View Document Permissions

Introduction

Using DocuShare, you can store, access, and manage documents created in a variety of popular formats. You add documents to DocuShare by uploading them from your computer or a network drive to a collection on your site. With the documents stored in a DocuShare collection, users connected to the network can use their browser to search for, view, edit, and download a document. You can lock files before you update them to make certain that files are only updated by one collaborator at a time. Many kinds of documents containing text are indexed automatically when they are uploaded into DocuShare, making them immediately available to be retrieved through the search menu.
New Terms

Icon – A symbolic or graphical representation of an object.

Refresh – Operation performed by the web browser to retrieve and display the most recent version of a collection or web page.

Upload – To copy a file, such as an MS Word document, from any of your local or networked drives to the DocuShare web site.

Lock – A standard document management procedure that indicates to other users that you are working on a file. Locking a file prevents other users from editing it at the same time.

3.1
ADDING A Document
You add a document to a collection by uploading it from a folder on your local drive or a network drive. The upload copies the document to the collection. Once a document is in a collection, it is available to others for viewing or collaborative work.

To add a document, you must be logged in and have Writer access to the collection.

To add a document to a collection:

1. Navigate to and open the collection to which you want to add the document.

2. From the Add menu, select Document.

The Add Document page appears.
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3. Enter the following information:

Filename—The complete path and filename of the document you want to upload. You can click the Browse button to navigate to and select the document.

If you enter the path and filename of a document that does not appear on the drive, DocuShare uploads an empty document.

Title—The title of the document. The title should be short, but descriptive, and can contain spaces and punctuation marks.

Max Versions—The maximum number of versions to save. 

4. Enter any optional information. Click a field name for a description of each property.

5. Click Apply to upload the document to the collection.

The Properties page for the document appears, displaying information about the new document. If you chose to route the document, a Routing Slip appears. (Pop ups must not be disabled) For information on how to use the Routing Slip, see Routing documents in the Docushare user guide.
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7.
Click on Appears In to return to your collection.

RESULT:  You have now officially become an online publisher of information on the web without knowing HTML! Remember to use meaningful titles and summaries to help yourself and others to find and use your information

3.2
EDITING Document PROPERTIES

Any user can view the properties of a document. You can change a document’s properties if you are the logged-in owner of the document or a logged-in user with Writer access to the document.

To view and change a document’s properties:

1. Open the collection that contains the document whose properties you want to view and change.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document displays the read-only properties.

3. Click the Edit tab.
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4. Change the properties you want. Click a field name for a description of each property.

NOTE: If your administrator created custom properties, they also display on the page. See your administrator for information about custom properties.

5. Click Apply.

RESULT:  You may edit any of the meta-information about your documents without changing the content of the document. Any changes you make are immediately available for viewing or searching.

3.3 LOCKING AND UNLOCKING A Document
If you are the logged-in owner of the document or a logged-in user with Writer access to the document, you can lock it to keep other users from editing the document. 

To lock a document:

1. Navigate to and open the collection that contains the document that you want to lock.

2. Click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.
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3. At the bottom of the page, click the Lock button.

On the View page, the Locked By property displays your name as the user who locked the document.

4. Return to the collection that contains the document by clicking the collection title displayed after Appears In. The Locked icon appears to the right of the document title.

Users can view the document, but they cannot check out the document for editing.

RESULT:  Once the document is locked, it will stay locked until one of two things happen: 1) You update the document and the lock is removed; or 2) You remove the lock from the document. 

IMPORTANT NOTE:  No other user can update a document while you have it locked. However, other users may view a document even though it is locked. “Locked by: username” will appear next to the file, alerting users that the file is currently being updated.
3.4
UPDATING AN EXISTING Document
DocuShare supports the complete development cycle of a document, allowing users to collaborate on a project. Document check-out and check-in ensures that only one user at a time edits a document. Version control maintains a user-specified number of document versions.

To edit a document and create a new version, you must be either the logged-in owner of the document or a logged-in user with Writer access to it. In addition, the document’s Add Versions property must be set to Allowed (default setting).

To edit a document:

1. Navigate to and open the collection that contains the document you want to edit.

2. Click the Check Out icon that appears to the right of the document’s title.
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The document opens in the browser window, or a window appears allowing you to open or download the document. When the document is checked out, it is locked, which prevents other users from editing it.

3. Edit the document.

4. Do one of the following:

· If the document opened in the browser, click the Back button. Click Yes to save your edits.

· If the document opened in its native editor, select Save As from the File menu.

5. In the Save As window, save the document to a location on your local drive.

Do not change the name of the document.

6. On the collection page, click the Properties icon that appears to the right of the document’s title.

The Properties page for the document appears.

7. At the bottom of the page, click the New Version button.
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8. On the Add Version page, click the Browse button.

9. Navigate to the location on your local drive in which you saved the edited document, select it, and click Open.

10. The path to the document appears in the Filename field.

11. In the Title field, you can change the document title. By default, the new version is assigned the original document title.

12. Optionally, enter any comments in the Version Comments field.

13. For Unlock Document, click No if you do not want to unlock the document after adding the new version.

14. When a document version other than the latest is the preferred version, you can click Yes in the Make This The Preferred Version field to set this version as the preferred one. Otherwise, click No to not change the preferred version.

15. Click Apply.

RESULT:  You now understand how to make changes to a document in DocuShare. Any changes to documents on your local or networked drives will be reflected in DocuShare only after you have uploaded a new version to the server. To view the history of a document, click the version history tab while looking at the properties of a document. 

Review

· Any type of file can be stored in DocuShare.

· The lock feature helps control updates to collaborative documents.

· Documents in applications such as MS Word, Excel, and PowerPoint are indexed for full-text searching.

Module 4: 
Managing Permissions

Objectives

Upon completion of this module, you will be able to:

· View object permissions
· Change object permissions 

· Change collection permissions
Introduction

Every DocuShare object has a set of associated permissions called its access list. Permissions are the access rights that a defined set of users and groups has to view, delete, or change a DocuShare object. The object's owner or any user with Manager access to the object can assign and change the permissions.

As the owner of the DocuShare objects that you add to your site, you can control the type of access users and groups have to those objects. When you add an object to a collection, you set the object’s initial permissions. At any time you can change the users and groups who have access to the object and the type of access each user or group has.

DocuShare provides the following access permissions that you can assign to users and groups:

• Reader allows the user or group to read the contents of the object and view its associated properties and permissions.

• Writer allows the user or group to edit the object’s properties and add new objects, including new versions of documents.

• Manager allows the user or group to delete the object and change the object’s access permissions and owner.

In addition, you can control who can see an object in a search results list.

4.1 VIEWING PERMISSIONS OF AN OBJECT
As a guest user or a user with Reader access to an object, you can view the object’s access permissions.

To view an object’s access permissions:

1. Locate the object whose permissions you want to view.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for that object appears.

3. Click the Permissions tab.

The Permissions page displays the object’s access list, which includes the object’s owner, the site administrator, and three DocuShare groups:

Administrators—The registered users who have full access permissions to all of the objects on your DocuShare site.

All Users and Guest—All registered DocuShare users and the guest user. (The world)
All Users Except Guest—All registered DocuShare users.

4.2 CHANGING PERMISSIONS OF AN OBJECT
You can change an object’s access permissions if you are the logged-in owner of the object or a logged-in user with Manager access to the object.

To change an object’s access permissions:

1. Locate the object whose permissions you want to change.

2. Click the Properties icon that appears to the right of the object’s title.

The Properties page for that object appears.

3. Click the Permissions tab.

The Permissions page for that object appears.

4. For Search Available to, click Anyone to allow guests and users to view the object in a search results list. Click Access List Only to allow only those accounts included in the object’s access list to see the object in a search results list.

5. If you want to change the list of users and groups who have access to the object, click the Change Access List button.

The Change Access List page appears.

6. In the Show field, select the type of account you want to display in the Possible Users/Groups field.

7. Do one of the following:

· To find a specific account, enter in the search field part or one of the following: user’s first name, user’s last name, username or the group’s title. Click the Go button.

· To display all accounts, click Show All.

· To display your favorite accounts, click Show Favorites.

8. In the Possible Users/Groups field, select the accounts to add to the access list and click the Add button. To select multiple accounts, use the CTRL key (Windows) or the Command key (Macintosh).

9. In the Selected Users/Groups field, select any accounts that you want to remove from the access list and click the Remove button. To select multiple accounts, use the CTRL key (Windows) or the Command key (Macintosh).

10. Click Update Access List.

The Permissions page appears, displaying the new access list.

11. Check the permission boxes you want for each user and group displayed in the access list.

12. Click Apply.
4.3
COLLECTION PERMISSIONS

When you change the access permissions of a collection that includes objects, you can choose how to apply the container’s permissions to its contents. You can choose to apply all of the permissions or only the changed permissions to either the container or the container and its contents.

You can change a container’s access permissions if you are the logged-in owner of the container or a logged-in user with Manager access to it.

To apply a container’s access permission to the objects in it:

1. Locate the container whose permissions you want to change.

2. Click the Properties icon that appears to the right of the container’s title.

The Properties page for that container appears, displaying the current properties.

3. Click the Permissions tab.

The Permissions page for that container appears.

4. Make the changes you want to the access list.

5. For Options, select one of the following:

· Apply all permissions to—Assigns all of the access permissions.

· Apply only changes to—Assigns only the changed access permissions.

6. Select one of the following:

· This container only—Applies the permissions to this specific container only. The permissions of the container’s objects are not changed.

· This container and its objects, including same objects that appear in other containers—Applies the permissions to the container and the objects in it. The permissions of the same objects that appear in other containers also are changed.

· This container and its objects, excluding same objects that appear in other containers—Applies the permissions to the container and the objects in it. The permissions of the same objects that appear in other containers are not changed.

7. Click Apply.

RESULT:  Changing permissions at the collection level can save time and make it easier to manage your documents. Keep in mind, however, that changing permissions at the collection level does not change the permissions of the collection’s content.

Review

· As a publisher on DocuShare, you control who can see, edit and delete your information.

· The permissions of all DocuShare objects can be customized.
Module 5: 
Searching In DocuShare

Objectives

Upon completion of this module, you will be able to:

· 
Perform Simple and Power Searches in DocuShare 

· 
Create a Saved Query

· 
Edit Saved Query Parameters

Introduction

DocuShare search features enable you to quickly find objects on your site. You can perform simple word searches by having DocuShare find the objects that contain the text you specify. You also can combine several search terms to find specific objects, such as all documents authored by one user that contain the word 12GeV in their titles. When searching for objects, you can search all of the collections on the site or a single collection.

When an object is added to a collection, DocuShare indexes and stores in a database the object’s properties (also called metadata) and, if the object is a document, it’s content. A search checks the database to find the objects that match your search terms. In addition, DocuShare uses a process called stemming to find objects that contain variations of the word you specify. For example, a search for the word bath will find the words baths and bathes.

New Terms

Saved Query – Container objects that allow users to store search results as a collection. 

5.1
PERFORM A SIMPLE SEARCH

From the home page or any collection page you can search for objects and content. You do not need to be logged into DocuShare to run a search.

To run a quick search:

1. On the home page or a collection page, enter one or more words in the Search field.

If you want DocuShare to search for an exact phrase or a phrase that includes a search operator, enclose the phrase in quotation marks (for example, "S&T Review").

2. If you are running the search from a collection page, do one of the following:

· Click This Collection to search the current collection only.

· Click Entire Site to search all collections.

3. Click Go.

DocuShare displays the search results. For documents, DocuShare either provides a snippet of the document content with the search term highlighted or displays the document’s abstract if the search term is not found in the content. You can click the Show/Hide Details button to control this display.
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RESULT:  Simple searches are useful if you aren’t sure what you’re looking for. You can simply enter a general keyword and then review the results. 
6.2 PERFORM AN ADVANCED SEARCH

1. On the home page or a collection page, click the Advanced link.
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2. The Advanced Search page will appear.
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3. Enter any search criteria.  Click the Search button. The Search Results Page appears.
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RESULT:  You can use the search-specific parameters of power searches to return a complex set of results.

5.3
CREATE A SAVED QUERY

A saved search query consists of a defined set of search terms. You can save a search in a collection to reuse it or to share it with other users. You can save a search query after running a search, or you can define a search query and save it.

To save a search query, you must be logged in.

To save the query used in a search:

1. Define your search terms and run a search.

The search results display.

2. From the Add menu, select Saved Query.
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The Add Saved Query page appears.
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3. In the Title field, enter a title for the saved query.

4. Enter any optional information. Click a field name for a description of each property. 

5. Click Save Search.

The Properties page for the query appears. You need to add the saved query to a collection.
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6. Do one of the following:

1. To find specific collections, enter one or more words in the Search field. Click the Go button.

2. To display all collections, click Show All.

3. To display your favorite collections, click Show Favorites.

7. In the Possible Locations field, select the collection(s) in which you want the saved query to appear and click the Add button. To select multiple collections, use the CTRL key (Windows) or the Command key (Macintosh).

8. In the Selected Locations field, select any collections in which you do not want the saved query to appear and click the Remove button. To select multiple collections, use the CTRL key (Windows) or the Command key (Macintosh).

9. Click Update Locations.

DocuShare adds your search query to the collection. When you click the saved query, DocuShare runs the search using the saved search terms and displays the results.
5.4
EDIT A SAVED QUERY

1. Open the collection that contains the saved query whose properties you want to change.

2. Click the Properties icon that appears to the right of the saved query’s title.

The Properties page for the saved query displays the read-only properties. 

3. Click the Edit tab.

4. Change the properties you want.

5. Click Apply.

6. Click the Edit Query tab.

7. Change the search terms you want.

8. Click Apply.

DocuShare saves the changes to the saved query.

RESULT:  You can edit the parameters of your saved query, which allows you to alter the results of a particular search. Changing the search parameters is useful if you decide that, for example, you want to search for additional document or object types using the same saved query.

Review

· You may change search parameters any time according to your search needs.

· For less complex searches, use the Simple Search.

Module 6: 
Additional Features

Objectives

Upon completion of this module, you will be able to:

· Change the location of an object

· Delete objects in DocuShare

· Install and mount Windows Client

Introduction

You can move a document to another collection or have the document appear in several collections on your site. Moving a document eliminates the need to delete the document and then upload it again. Although a document can appear in several collections, there is only one copy of it, which saves space on your DocuShare site.

To change a document’s location, you must be logged in and have Writer access to both the document and the new collection.

DocuShare is a community-maintained system. It is the responsibility of the users to remove information that is out-of-date or no longer useful. The owner of an object or any user with Manager permissions to an object can delete that object in DocuShare.

The DocuShare Windows Client is an application that allows you to access and manage DocuShare files from within Windows Explorer. Once installed and mounted, DocuShare will appear as another drive on your regular Explorer tree structure. Using the Windows Client, you can access and interact with DocuShare just as you would with your local or network drives. For example, you can view the contents of DocuShare collections, open and edit files, copy files to and from (or within) DocuShare by dragging and dropping, and even use a combination of Explorer and the web interface to manage files. You must have either Windows 95, Windows 98, Windows NT 4.0 or higher to use the DocuShare Windows Client.
New Terms

Orphaned File – A file that is not associated with any collection. Although they are not visible, orphaned files still exist in the DocuShare repository. A file may become orphaned by improperly editing an object’s location or improperly deleting a collection.
7.1
EDITING AN OBJECT’S LOCATION

1. Navigate to and open the collection that contains the document that you want to move.

2. Do one of the following:

· Click the checkbox that appears next to the document’s title. From the Edit Selected menu, select Change Location. On the Confirm Change Location page, click Confirm.

· Click the Properties icon that appears to the right of the document’s title. On the Properties page for the document, click the Locations tab.

The Change Location page appears.
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3. In the Sort By field, select Title to display the possible locations in alphabetical order or select Handle to display the possible locations in numerical order.

4. Do one of the following:

1. To find specific collections, enter one or more words in the Search field and click Go.

2. To display all collections, click Show All.

3. To display your favorite collections, click Show Favorites.

5. In the Possible Locations field, select the collection(s) in which you want the document to appear and click the Add button. To select multiple collections, use the CTRL key (Windows) or the Command key (Macintosh).

6. In the Selected Locations field, select any collections in which you do not want the document to appear and click the Remove button. To select multiple collections, use the CTRL key (Windows) or the Command key (Macintosh).

NOTE: Make sure at least one collection appears in the Selected Locations field. Otherwise, the document will become orphaned, which means it will not appear in any collection.

7. Click Update Locations.

RESULT:  You can change the location of an item or make it appear in multiple locations by creating new pointers to the item. 

7.2
DELETING AN OBJECT

1. Open the collection that contains the collection or document that you want to delete.

2. Do one of the following:

· Click the checkbox that appears next to the document’s title. From the Edit Selected menu, select Delete.

· Click the Properties icon that appears to the right of the document’s title. On the Properties page for the document, click the Delete button.

· The Confirm Delete page appears.

NOTE: If a minus sign appears in the checkbox that precedes the document, then you do not have Manager access to the object and cannot delete it.
NOTE: If you are deleting a collection, you will have the option to do one of the following:

· Select Collection and Contents to delete the collection and all of the objects in it.

· Select Collection Only to delete the collection, but not its contents. 

(Deleting a collection without deleting its contents will orphan the contents of the collection. Orphaned objects still exist within DocuShare and are searchable, but are not visible or accessible to users. Only a Site Administrator can recover orphaned objects.)
3. Click Delete to remove the document from your site.

If you do not want to delete the collection or document, click Cancel.
RESULT:  Regular review of your collections will help keep the amount of non-useful materials in your DocuShare workspace to a minimum. Taking the time to do this will make it easier for you and your coworkers to make the most efficient use of the system. 
7.3
INSTALLING / USING THE WINDOWS CLIENT

A. Installing the Windows Client

Please Note:  If you have a red DocuShare Xerox logo icon on your desktop, you do NOT need to install the Windows Client.  The Client is already installed.  Please go directly to the next section, “Configuring the Windows Client Properties”.

1. Close down all Windows applications.

2. Go to the Help section from the web interface.

3. Click on the “Downloads” tab

4. Click the DocuShare Windows Client link.

5. Click the blue Download DocuShare Windows Client link towards the bottom of the page.

6. Follow through the prompts by clicking “Next”

7. On the Select Options menu, make sure all the “Install” checkboxes are checked.

8. On the Select DocuShare folder location, select “No, place this folder on my desktop.”

9. On the next Select Options menu, check both checkboxes.

10. Click “Finish” and restart your computer.

B. Configuring the Windows Client Properties

1. Nothing at this time
C. Mapping the Server

1. Double click the red DocuShare Xerox logo icon on the desktop.

2. Double click the Map Server icon.

3. Enter https://jlabdoc.jlab.org/docushare/ as the DocuShare home URL.

4. Select “Use existing DocuShare account.”

5. Enter your Jlab user name and password.

6. Click “Options”. Select Jlab as the Domain from the drop-down list. (Note: you must click on the down arrow on the drop-down box to scroll to the Jlab option.)  
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7. Continue through and click “Finish”.  

D. Mapping a Specific Collection

1. Double click the red DocuShare Xerox logo icon on the desktop.

2. Double click the Map Collection icon.

3. Select DocuShare and click “OK”.

4. Select the collection and click “OK”.

E. Configuring Word Documents to Open in Word

1. Double click the My Computer on the desktop.

2. Go to Tools > Folder Options.

3. Click on the “Files Types” tab.

4. Scroll to Doc – Microsoft Word Doc.

5. Select it and click the “Advanced” button.

6. Make sure that “Browse in same window is unchecked.

· Note: You can do this for other files types like PowerPoint presentations, etc.

F. Managing Files

1. Right click on any file in the Windows client to view all the actions that can be done:

· "Check Out" / "Check Out With…"  - for editing files.

· "Browse" - for viewing files.

· Lock / Unlock

· Open in Web Browser - for viewing files.

· View / Add Versions

· Rename

· Properties
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RESULT:  This is an awesome tool!!  You can now view, manage, and edit DocuShare files directly from Explorer or an editor application. See Chapter 11 of the User Guide for more information about using the DocuShare Windows Client.

Note:  The browser interface is great for searching the DocuShare server, finding and downloading information, and occasionally uploading a file.  The Windows Client should be the tool of choice for those involved in heavy-duty content management and collaboration.

Review

· DocuShare objects can appear in multiple locations.

· DocuShare collections work best when you delete out-of-date materials.

· The Windows Client allows you to work with a DocuShare repository of files (or several) from within Windows Explorer.
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